
Mimaki CJV150-75
Wide Format Printer

Introduction: The Mimaki Wide Format Printer/Cutter is a highly versatile tool that lets you 
print on large format rolls of media. Some of these options are also capable of being cut into 
custom shapes. The machine is currently equipped with six media types to allow you to create 
anything from stickers and window clings to banners and canvas prints.
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General information
Parts of the machine

The red front panel is only located on the UV printer.

Turning on/off the machine

Press the End/Power button and hold it until the screen turns on.

When attempting to turn off the machine, press and hold the End/Power button until it asks 
“Turn off Power? [ENT]” in which case you can press the Enter button to con�rm.
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Loading media
1. On the back of the machine is a lever with a gray handle. Grab this and lift it fully to 

disengage the rollers.

2. Wind the media on the machine back up and secure it with a Velcro strap.

3. On the right side of the roll is a holder with a black knob. Unscrew the knob to loosen the 
holder. Brace the roll and slide the holder over to the right to free the media roll. Set the 
media roll aside onto a stand.

4. Take the new media roll and orient it so the edge of the media is coming from the bottom 
toward the back of the machine.
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5. Place the roll onto the leftmost roll holder.

6. Then slide the right holder over so it sits snugly into the end of the roll. Tighten the knob.

7. Remove the Velcro band and feed the media up into the back of the machine. It should �t 
cleanly under the pinch rollers and begin to exit the front of the machine.
a. The vacuum table should engage at this point holding the media down while you make 

adjustments. (The vacuum table is only on the solvent printer.)
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8. UV Printer only - Return to the front of the machine and lift the front red panel until it 
clicks in place.

9. Return to the front of the machine. Grasp the media in the center of the roll. Gently pull 
forward until the media catches, then lightly wiggle the media left and right to ensure the 
roll is straight.

10. Place the hold downs over the left and right sides of the media and ensure that a pinch 
roller is sitting within the edge of your media.

a. Note, for smaller rolls you may only use three pinch rollers, in which case the left most 
roller will not be on the media.
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b. Also note, the pinch rollers need to be located somewhere within the triangles shown on 
the rail above them. Ideally you will have a pinch roller 1-2” from either end of the 
roll.

11. Lower the lever on the right side of the media to lock the pinch rollers down.

12. UV Printer Only: Close the front lid until it clicks in place on both sides. Press Enter to 
con�rm the lid is closed.
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13. On the screen for the machine it will ask if you are using a roll or a leaf. If using a roll, 
press the left button.

a. A leaf is a loose piece of media not bound to a roll. Press right to select leaf if using 
this, though most of the time you will be using a roll.

14. After it is done scanning the width of the roll, it will display the width for a couple 
seconds.

15. You will then need to con�rm how many rollers you are using. For large rolls it will be four, 
for smaller rolls it may be just three. Press up or down on the panel to select the 
appropriate number, then press Enter.
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16. Press and hold the up button on the control panel to roll the media back to reduce waste. 
The front edge of the paper should be within the front 1” of the steel plate while still 
remaining under the hold downs.
a. Note if you’re using canvas, the patron may wish for some extra waste material on the 

edges to wrap the canvas around a frame. Account for that desire when rolling the 
material back so as not to cut off too much from the canvas print.
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Preparing a design
When working with banner, canvas, or poster paper, you cannot add custom cut lines to these 
media types. These are intended only for printing. If you are only printing your design, an 
EPS, JPG, PDF, or TIFF �le will be all you need. You can skip to “Opening a design.”
If you desire to add a cut line around a sticker, window cling, or heat transfer design, 
proceed to the next section, “Adding a contour cut” to achieve this.

Adding a contour cut
Sticker, window cling, and heat transfer media can be custom cut with a contour cut line. These 
lines are added using Adobe Illustrator and the RasterLink plugin. There are three common 
ways to create a cut line and we’ll cover the different approaches below.
For all versions follow these steps to get started, then choose the appropriate method from 
the following sections.
1. Open Adobe Illustrator located on the desktop of the computer by double 

clicking the icon. Once the program is open, open your �le in Illustrator. Do not 
create a new document.

2. In the Properties tab in the top right of the screen you’ll see the document units. If it is not 
set for Inches, select that from the drop down list.

Adding a simple shape

Using one of the following methods, create a path surrounding your object.
a. Pen Tool - De�ne each point along a path that can be used as a cut line.
b. Rectangle, Ellipse, Polygon, or Star - Add a standard shape to serve as a cut line.
c. Pencil - Freehand draw a line that will serve as a cut line.

Whichever option you choose to create the path, the following steps apply.
1. In this example we’ll use a rectangle. For this we’ll use the tool to draw a rectangle larger 
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2. In the RasterLink Tools plugin in the bottom right of the screen, select the �rst icon that 
looks like a small knife. This will convert your shape to a cut line (seen as a red line in this 
example, but should appear green when not selected.)

Adding a contour cut from vector path

If you have a vector image to begin with, your options are very easy to work with.
1. Select your image.
2. This gives you the option for an offset cut. This can add a small white border around the 

edge of your design. To do this, you’ll select the second option of the top row in the 
RasterLink Tools plugin. You’ll then be given a dialog box like this.

3. Here you can say how thick you want your offset to be. If you want the cut line to be just 
on the direct outside edge with no offset, say 0 for your offset. If you want your image to 
have any interior holes cut out as well, check the box for “Extract the Inside.” If however 
you want just an exterior cut with the interior �lled fully, make sure this box is not checked. 
Note you can adapt the corners using the joins function, however Round often gives the 
best outcome so we recommend you leave it on that setting. Then click OK.

4. You should now see a custom path around your design. If you don’t like how wide the 
offset is, you can select the line, delete it and repeat the process again.
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Using Image Trace to create vector path

Image Trace is a very useful tool for creating a vector image out of a raster image. Not 
every image works well with this process. The simpler and higher quality the original design,  
the better the output will be.
There are a few ways to go about this process. One involves converting the image itself into a 
vector (good for simpler clip art) and one that involves creating a silhouette of the design 
(better for lower quality or more detailed images). We’ll start with converting.
1. Open your image in Adobe Illustrator and select it. Note there will be a button for Image 

Trace below the image. We want to ignore this button for now.

2. Find the Image Trace tab on the right side bar. 

3. At the top is a drop down �lled with various presets. These are a useful starting place for 
the process, though any of them can be created or modi�ed using the sliders in the panel 
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to better re�ne your image.
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4. For this image, we’ll use the “6 Color” preset as we have approximately six colors in our 
design.

5. This will create our vector image. Note the white background in this image is also 
considered a color and is a part of the image.

6. Navigate to Object > Expand then click OK. This will convert the image from the Image 
Trace function into a set image.

7. In this instance we’ll want to delete the white background. This can be found at the bottom 
of the group within the layers panel. Select this item and delete it.

8. This will leave you with just your object. Here you can use the offset tool to create your 
cutline around your image, be it on the edge of the image or offset from it.

Instead of adding a cut line around our image by tracing the image into a vector image, we 
can use some of the same features to create a cut line for a more complex image by using the 
silhouette preset.
This will be useful if your image has a lot of shading, more than a handful of colors, or is not 
quite as high quality to start with.
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1. To start this process copy and paste your image. As the Image Trace process alters the 
selected image, we want a copy of it since we’re using the Image Trace feature purely to 
create a cut line, not alter the original image itself.

a. Illustrator will paste the image away from your original, so overlap your images so 
they are in the same position.

2. Select the “Silhouette” preset from the Image Trace menu. If you need to, you can adjust 
the threshold up or down to include more or less of the image within the silhouette. The 
key thing you’re looking for is to have the complete outer edge of the image selected at 
minimum.

3. Expand the design by going to Object > Expand. In this instance the background is 
ignored leaving you with just the shape to create your cut line from.

4. If you have internal holes like the eyes in this instance that you don’t want to cut out, you 
can use the Direct Selection tool to click on one of the nodes of the shape and then press 
Delete twice to remove this piece. Repeat this for every object you wish to delete.
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5. Once your design is where you want it, use the Offset tool to create your cut line from the 
silhouette.

6. After the cut line is created, click on the silhouette and delete it so only the cut line and 
your original image remain.

Exporting your image
No matter which method you used to create the cut line, you’ll need to �nish the process and 
export your design.
1. Open the layers panel and create a new layer.

2. Take the cut line element from the �rst layer and drag it into the new layer. If you have 
more than one cut line, put all of them into the new layer.

3. Under Object, �nd Flatten Transparency.
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4. If your design is highly detailed with a lot of small parts, adjust the slider to go all the 
way to the right. For a standard image, you can leave it as is. Then press OK.

5. In the bottom right of the screen is the RasterLink plugin. Click the �fth button that says 
“RL” on it. This will let you save your �le ready to print. Save it where you want to and 
press OK on any of the boxes that pop up.
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RasterLink
The software to operate the wide format printer is called Mimaki RasterLink. It is located on 
the desktop of the computer. The sidebar of the software has a variety of tool options. These 
are listed below. Those that are in bold have a section of this document associated with it. The 
others are not often used. See a staff member if you have questions about any of these.

Opening a design
1. Open Mimaki RasterLink7 on the desktop by double clicking the icon.
2. Once the software loads you will see the following screen.

Properties
Arrange
Quality (Advanced)
Crop (Advanced)
Layout
Tiling
Step and Repeat
Variable Edit
Execute
Special Plates (UV only)
Composition (UV only
Layers
Color Correct
Favorites
Duplication
Backup/Restore
Delete
Info
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3. To load your image go to File > Open. Here you’ll �nd a �le browser. You can navigate 
to your design. Open it, then choose the media type you plan to use on the right side. 
Click OK.

4. Your �le will take a moment to load and then appear at the bottom of the Job List in the 
center of the screen. If your design is a single image, it will appear with just a single 
Color attribute. If you have a design with a cut line, it will appear with both Cut and 
Color attributes linked together.

5. Here you have a variety of options. You can read more about them in the following 
sections titled “Properties,” “Arrange,” “Crop,” “Variable Edit,” “Quality” and “Special 
Plates/Composition.” To directly proceed with creating your design, go to “General Print.”

Arrange
If you want to print multiple jobs together in one print job, you need to arrange these objects 
together as one job in the Job List. To do this, follow these steps.
Note that print jobs with a cut line cannot be arranged together with a print job without a cut 
line.
1. Select all of the jobs you wish to print together by holding shift and clicking on each one 

you want to include.
2. Select Arrange on the side bar. You will be presented with these options.

3. You have a couple of options here, but it’s recommended to ignore them for now and 
apply them in the General Print section.

4. Click Arrange.
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5. On the Job List your jobs will now be linked together with a set of lines.

6. When you navigate to the Layout tab later, you will see all your arranged parts as they 
appear on the page.

7. To undo an arrangement, go back to the Arrange screen and click Release. You can 
release all the jobs by selecting them all, or you can select an individual item and release 
just one item at a time.

General Print
Before you can print you need to set up the page using the General Print screen. Clicking the 
�fth option on the sidebar will reveal this screen for General Print.

The main areas to pay attention to this the center area labeled Image/Cut Edit 
and the layout preview on the right side. Beginning with the layout preview, you’ll 
see your selected design as it will appear printed on the media. There are two 
kinds of lines you’ll see around your design. A dashed blue line shows the full size 
of your �le, and a dotted red line indicates any cut lines on the design.
If you have a signi�cant amount of white space around the design within the blue 
dashed line you may wish to return to your design and see if you can crop out the 
excess space. This will save you time on the printing as well as on the cost of used materials.
Note, the colors and resolution of your image preview are intentionally bad and are only 
used as a thumbnail view. Your printed design will look much better than the previewer 
suggests.
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Image Edit

Going down the list on the Image Edit tab, you’ll see the following properties you may or may 
not wish to modify.
• Scale
◦ At the top of the layout screen is the scale setting. You can 

adjust your size based on percentage or by inch. The scan 
is the left to right and the feed is the up and down. Note 
this is in relation to how the image is on the layout preview, not for the image itself. If 
you adjust any of those and want them to go back to the size it imported in as, you can 
click the Actual size button to revert any changes.

• Rotation
◦ Rotation can be used to better �t your design on the page. Typically used to print an 

image longer than the roll is wide, rotation lets you rotate your image in 90 degree 
increments. Most commonly though you’ll use the 90 degree to make a particularly wide 
image run down the length of the roll. Here you can see the preview of this happening.

• Position
◦ Position will let you move your design around the page. With a single item, you can click 

and drag the image in the layout preview and modify it’s position manually. However 
you can adjust this precisely by inputting exact coordinates. The scan direction is the left-
right direction and the feed direction is up-down.

◦ Most commonly though you’ll check the box for “Arrange in the Center” to place your 
whole design in the center of the roll. This can help with making sure an image on a 
banner or canvas �ts exactly in the center for spacing, or for making a series of stickers 
evenly spaced on the roll.

• Copy
◦ If you need multiple copies of your design, increasing the count here will let you adjust 

how many appear on the layout preview. Once the number of copies exceeds the width 
of the media, it will begin a new row above the last one.
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◦ Sometimes it does not show duplicate copies of your project, just creates an empty box, 
or one with just a cut line showing. It will print extra copies of your project wherever 
there is a box, it just doesn’t always render them in the preview.

◦ If you are planning to create a large quantity of images, especially with cut lines, it can 
be helpful to set up only a few rows at a time, and perform multiple executions of your 
design in the Execute screen. This can help make sure you don’t waste a lot of material in 
case there is an problem partway through the process.

• Layout
◦ This allows you to modify the spacing between your designs 

when you have multiple objects arranged or when you have 
increased the number of copies. Once again, the scan 
direction is the left-right direction and the feed direction is up-
down.

◦ Space is the amount of space between the bounding boxes of each object and is 
typically what you’ll use. The other option is pitch, which allows you to dictate how far it 
should be from the origin of one image to the origin of the next image. 

• Register mark
◦ When you have a cut line, you need to include registration marks with your printing, so 

the machine can verify where it needs to cut once the image has been printed. For our 
machine, choose the second option under Mark Shape.

◦ The only other aspect you need to pay attention to is whether you want registration 
marks around individual items or the whole project. Individual marks will ensure the 
highest accuracy across multiple objects as it will scan for marks around each object 
before cutting each item. Whole marks will speed up the cutting process as it will only 
scan for marks once.
◦ Generally, if printing multiples of the same image in an exact grid, you can use 

Whole marks. If you are cutting a large or intricate design multiple times at once, it 
may be best to work with Individual marks instead.

• Cut Line
◦ Below crop mark is the ability to add a cut line. This is a 

helpful tool for a print only project with a lot of white space 
along the edges, as this adds a dashed line around your 
image. This way you know once the project is printed where to cut the overall media 
down to �nished size.
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Cut Edit

The second area within this step is the Cut Edit located in a tab beside Image Edit. That will 
display the following information.

To ensure your project has the appropriate cut pro�le, you can select the Cut Condition to be 
User De�ned. This will then let you choose from a list of choices for your cut tool. 

You can also modify individual attributes such as speed, pressure, and offset. This should only 
be done if you’re familiar with the machine and are experimenting with a new media type. 
Be sure to select Apply if you make any changes.

Execute
The �nal section you’ll use every time is Execute. This is the ninth option on the sidebar and is a 
little button that says GO on it. After you have completed all the layout options for your 
project, you’ll click this and be greeted with this screen.

1. At the top is execution order. If you are just printing, you’ll be given no choice and Print 
will show in that box. If you have cut lines it will give you the options Print < - > Cut, Print, 
and Cut. You want to choose “Print < - > Cut” if you have cut lines.

2. Leave the next option as RIP and Print.

Media Pro�le
Permanent Sticker CUT1
Movable Sticker CUT2
Heat Transfer CUT3
Window Cling CUT4
Half Thru Cuts CUT5
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3. Last is Execution Times. This will repeat whatever was on your layout preview this many 
times. If you are making a large quantity of items it’s recommended to layout a single row 
or two of your project, then repeat the execution a certain number of times to achieve 
your desired quantity.

4. Once your settings are chosen, click Start on the screen.
5. On the printer, if you don’t see REMOTE listed above FUNC3, you’ll press SEL a few times 

until the it appears there. Press FUNC3 to switch the printer into Remote allowing the 
computer to send the image over. 

Removing your �nished project from the roll
Once your project has completed, you can cut it off of the roll.
1. Press FUNC3 to return to the Local state.
2. Press up or down one time. FUNC2 should show as [CUT]. Press FUNC2.
3. It will ask you to con�rm a cut. Press ENTER to con�rm.
4. Hold the media while the cut performs to keep it from dropping to the ground.
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Advanced
Special Plates/Composition     (UV printer only)
If using a clear material, you’ll need to apply a layer of white to your design so the image 
doesn’t get faded out. In addition, the following steps also work to make your design coated 
in a clear varnish.
1. Select just the Color job of your design for this process from the job list.
2. Click the “Special Plates” option on the sidebar, option 10 on the list.

3. Here you’ll select from the drop down where you choose to use either white or clear. 
Select the appropriate one for your design. (Note, if you want to use both, you’ll perform 
this process for one and then repeat for the other.)

4. When it comes to the “Created area” you’ll select either Whole image or Valid pixel. 
Whole image will look at the outer bounds of your image and �ll it completely. Useful if 
you have a photograph or square design. Valid pixel will look at your design and apply 
your special color to anywhere that has a color value other than pure white.

5. Once you’ve selected your settings, click Create. You’ll then have another layer in the job 
list with a preview of your white or clear image.

6. To assemble them together, you’ll select the color and white/clear layers and choose 
Composite (option 11) on the sidebar. Here you’ll be given a screen on the right side with 
a list of all the parts. You can drag these to rearrange their order to function in the order 
you want with the bottom layer happening �rst, and the cut always happening last. 
Typically you’ll put white at the bottom of the list. 
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a. Note, the output order numbers these, and you’ll likely have your color and one of the 
special colors sharing the same number. This is �ne. The machine is able to print one 
special color and the regular color together.

7. Once these are arranged properly, click Composite. Note if you want to adjust this 
arrangement in the future, select Release and then make any adjustments.

8. Your layers should now appear in the job list as fully linked together in the order you 
chose.

9. From here you can open your �le and print them as you normally would as listed above.

Quality
If you forgot to set your media type in the Open screen, you can modify it in the Quality 
menu. Additionally this provides the ability to tweak and play with the settings of a material. 
This should only be done with the help of Maker Studio staff.

Some key elements to be aware of are:
• Print time will display an estimated printing time based on the current settings. Note this is 

not include the cutting time which in some cases can take longer than the print time.
• Resolution if you need to modify the DPI of your printed image.
• Pass is how many passes go over the media. Increasing this number has the potential to 

make your printed image better, but at the cost of increased print times.
• Overprint will print full colors over top of other colors. This can result in some interesting 

designs, but should only be used if the design was created with that effect in mind.
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Crop
With a print only job without a cut line, you have the option to crop your image from the 
original size. If you click option 4 on the sidebar for Crop, you are presented with this screen.

Here you can move the top, bottom, left, and right of your image in to make the overall 
design smaller. In the above example, we’re cutting out parts of the river and sky to 
emphasize more of the city with the image. Note this also shows you how large your original 
image is, but does not allow you to modify that. You would need to modify the size in the 
Layout tab or in a different photo editor prior to bringing it into RasterLink.

Variable Edit
If your design is a series of the same design with one bit of custom text like a nametag, you 
can use the Variable Edit feature to create one design and apply the text to it, giving you a 
total quantity of designs that each have their unique element. It can also be used to create a 
numbered series. 
Note, this only works if your design is in an EPS format. If you’re using a sticker for this, then 
you should already have one after creating the cut lines. But if you upload just a single image 
without a cut line, it does need to be in the EPS format to work.
1. In Excel, or another spreadsheet program, create a list where the column has a header, 

then each unique item is listed in that column. Here we’re making nametags so we’ll 
provide a list of names under the header “Name.”

2. Save this �le as a CSV. This will not work if saved in a different format.
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3. Excel will give you a warning, click Yes on the warning.

4. In Rasterlink, open your �le and click on the Color element of it. Then choose the eighth 
icon on the sidebar for Variable Edit.

5. Here you’ll check the box for Variable Edit on the left and then click the folder to open 
your CSV �le.

6. If you need numbers on each of your items, press the button for Add Numbering and an 
additional column of numbers will be applied.

7. The right side shows your design. You can click and drag to create a box. This box will 
contain the text for whichever column was selected on the left. In this instance the names 
were selected so the box will contain the names.
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8. In the center you can modify how your text looks. You can adjust the size and location of 
the box you’ve created, the position inside the text box, and the font and size of the text. 
As a note, the size you need the text to be is typically larger than you think it is. It may 
take a few times to �nd the right size text.

a. Note the text is locked to the size of the text and not the text box. You may need to 
click through some of the options on the left to ensure that none of your text is getting 
cut off if it’s larger than the others. For instance, if you size the text to �t the name 
Sam, it may not fully �t the name Samantha.

9. The last section lets you de�ne how your text looks with colors. There are four options, two 
of which are turned off by default. The two by default are font color, and background 
color. You can click two buttons in the Text Design section to add an outline and a shadow. 
If you do, there are two options to adjust the width of the outline and how offset the 
shadow is. For example, here is what it could look like if you enabled them all.

10. Once your design is set up the way you want, navigate to the General Print screen. Your 
design will appear in the quantity you have based on the entries in the CSV, but they will 
not show the parts added through Variable Edit. They will print all of the Variable Edit 
features as laid out though. They will all be stacked along the right side by default, but 
you can adjust them to �t however you need. This is done by changing the layout style at 
the bottom of the preview from Sequential to Minimize. You will also want to put any 
spacing between the designs as needed at this time.
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Additional Information
Mark Detect
If a design was printed but was not cut, you can possibly salvage the project as long as 
registration marks were printed. If marks were printed, return the page so that the start of 
the printed area is near the print head. Lock it in place as you would any normal roll. Then 
follow these steps.
1. Press the End/Power button once to enter into Mark Detect mode. This will bring out the 

red dot laser for scanning.

2. Use the arrow keys on the control panel to move the red dot to be inside the �rst mark. If 
you visualize the L as a square, position the red dot in the center of the square as shown 
below.

3. Then press the Enter button. The printer will now scan for a mark. 
4. If the process is successful, the laser will return to the side and your new start position will 

be locked in. You can then return to the Execution tab and select just Cut from the job 
type.

5. If it was not successful, try the process again, adjusting the placement of the laser slightly.
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Using the Grommet Press
You can use the grommet press to add grommets to make it easy to hang your �nished 
project. It is typically used with banners, but can be used with a variety of materials including 
fabric.
1. Set the grommet press on the table and lift the arm to the upright position.

2. Take a bottom grommet piece with the rounded side down and put it in the lower die. 
Take the top piece and put it on the upper die with the rounded side up and the post 
facing down.

3. Take your banner and place a template on the corner or along the edge where you want 
the grommet to be. Mark it with a pen.
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4. Align your mark with the post of the grommet press by slowly lowering the handle until 
you have aligned the two.

5. Press �rmly down on the handle. It may be helpful to do this process on a lower table to 
get a bit more leverage on the press.

6. Release the handle. If your grommet was not pressed fully and is loose, realign the 
grommet to the dies and press it a second time until �rmly closed. These are a little loose 
so don’t think you need to get it completely snug.
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For Internal Staff
This section will cover maintenance for the two printers. We’ll begin with the solvent printer 
then move onto the UV printer.

Changing ink (Solvent printer)
When the machine senses there is not enough ink left, it will prevent you from printing until the 
cartridge is replaced. Alternatively if the ink has expired and is a couple months past its 
expiration date, it will need to be replaced as well.
1. Pull a new cartridge out of the blue bag it comes in. Remove any booklets or papers 

taped to the side apart from the label.

2. Write the current date on the end of the ink cartridge for inventory tracking purposes.

3. Remove the old ink cartridge from the machine by pulling outward until the entire 
cartridge is removed.
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4. Place the new cartridge in with the chip facing to the left.

5. Write empty on the cartridge and place it into the box outside the IT Coordinator’s of�ce.

Changing washing �uid (Solvent printer)
Occasionally you will get an error message about washing �uid like this.

When this happens you need to check or replace the washing �uid cartridge. On the side of 
the machine near the screen is a slot for washing �uid to �t in. This is used in self-cleaning of 
the machine and runs out from time to time. When the printer asks you to check, pull out the 
cartridge and check if it’s near empty. You mostly need to do this by shaking it and listening 
for liquid inside. Regardless, at this time contact Perry Pro Tech for a replacement cartridge. 
They last approximately two months.
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Cleaning (Solvent printer)
The maintenance guide provides more detail for this process. It is located on top of the 
printer. A PDF is available in the DCDL Drive’s Maker Studio folder within the manuals folder. 
This process should be performed every Monday and Thursday morning.
1. While in the Local setting, navigate to Menu > Maintenance > Station Maint. > Carriage 

Out > Head Maintenance. The print head will now navigate to the left hand side of the 
printer.

2. On the left hand side, open the front door and lower the trap door to gain access to the 
print head.

3. Take the bottle of cleaning solution and pour a small amount into the lid of the bottle.

4. Take a micro�ber cleaning pad and dip it into the cleaning solution. Lightly brush the 
bottom of the print head to remove any old or excess ink. A few drops might appear 
after cleaning. This is normal and there’s no need to ensure every drop is removed.
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5. On the right hand side is a small blue wiper. Pinch both sides of it and remove the wiper 
from the machine. Using a cotton swab, dip it in the cleaning solution and proceed to 
clean all the used ink off of the wiper. It’s important to get in all the cracks as best you 
can and get any dried ink out, not just off the blue part itself.

6. Take a cotton swab and clean out around and inside the spot where the wiper sits. Once it 
is cleaned, replace the wiper into the slot.

7. Take a cotton swab and dip it in the cleaning solution. Wipe around the edge of the 
cleaning cap. This often removes the dried ink from around the edges of the cap.
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8. Once this is done you can pour any remaining cleaning solution left in the cap down the 
center of this. Pour slowly as it will over�ow quickly. This will help �ush old ink down into 
the waste bin.

9. Replace the bottle and close all the doors, then press Enter on the printer to retract the 
head.
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Changing ink (UV printer)
When the machine senses there is not enough ink left, it will prevent you from printing until the 
cartridge is replaced. Alternatively if the ink has expired and is a couple months past its 
expiration date, it will need to be replaced as well.
1. Put on a pair of nitrile gloves before performing this step as the ink can be hazardous to 

skin. They are kept on top of the printer itself.
2. Unlock the bottle by pressing the lever to the unlock position and lift outwards. Be sure to 

tilt the bottle slightly to the side and let any ink drip into the machine.

3. Wipe off the cap with a tissue or paper towel to clean up the majority of any liquid ink 
still on the surface.

4. Peel off the chip from the bottle and carefully set aside for later.
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5. Cut the seal and take the lid off of the bottle. 

6. Remove the cap off of the old ink bottle and transfer that to the new ink bottle.
7. Lightly twist it on without tightening it.

8. Using the cap tightener, align the pins with the slots in the tightener.

9. Twist the tightener until the red arrow reaches the green striped area. Do not overtighten 
past this point.
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10. Swirl the bottle lightly (not shake) before aligning the pins on the cap with the slots in the 
reservoir and insert fully.

11. Lock the cap in place by closing lever to the lock position.

12. Wipe up any spills right away and clean any surfaces that had ink on it with isopropyl 
alcohol. This can be found in a spray bottle near the 3D printers.

13. Unwrap the chip that was set aside earlier.
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14. Remove the old chip from the associated slot in front of the ink bottles. The light should be 
�ashing red. You can throw this older chip away.

15. Insert the new chip into the slot fully. The light should turn blue if installed properly.

Cleaning (UV printer)
The maintenance guide provide more detail for this process. It is located on top of the printer. 
A PDF is available on the L Drive in the manuals folder. This process should be performed 
every Monday and Thursday morning.
1. While in the Local setting, navigate to Menu > Maintenance > Station Maint. > Carriage 

Out > Head Maintenance. The print head will now navigate to the left hand side of the 
printer.

2. On the left hand side, open the two panels to gain access to the print head.
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3. Take the bottle of cleaning solution and a micro�ber cleaning pad.

4. Dip the micro�ber cleaning pad into the cleaning solution. Lightly brush the bottom of the 
print head to remove any old or excess ink. A few drops might appear after cleaning. 
This is normal and there’s no need to ensure every drop is removed.

a. Note, you should not mix the ink between the two heads. Use either side of one pad, or 
two separate pads when cleaning each print head.

5. Open the front panel. On the right hand side is a small blue wiper. Pinch both sides of it 
and remove the wiper from the machine. Using a cotton swab, dip it in the cleaning 
solution and proceed to clean all the used ink off of the wiper. It’s important to get in all 
the cracks as best you can and get any dried ink out, not just off the blue part itself.
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6. Take a cotton swab and clean out around and inside the spot where the wiper sits. Once it 
is cleaned, replace the wiper into the slot.

7. Take a cotton swab and wipe around the edge of the cleaning cap. This often gets dried 
ink around the edge so be sure to get any dried ink off in this process.

8. Close all the panels and doors, then press Enter on the printer to retract the head.
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